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Document History

1 Note

Before you start the implementation, make sure you have the latest version of this document.

The following table provides an overview of the most important document changes.

Table 1:
Version Date Description
1.0 2012-07-10 First customer shipment
2.0 2013-06-07 RTC of SPO2 (Feature Pack 1)
Several document changes related to new SPO2 features, for example:
e |ssue processing with Digital Signature
e Search for issues with Enterprise Search
e BAdI for enhanced authorization check
2.1 2013-09-27 RTC of SPO3
Section 2.1 changed due to the release of SPO3 for installation on SAP NetWeaver
AS ABAP 7.4 or SAP NetWeaver AS ABAP 7.4 for Suite on HANA.
3.0 2014-06-06 RTC of SPO4 (Feature Pack 2)
Several document changes, for example:
e Section 2.2: NOTE paragraph deleted since the Scenario & Process Component
Listis no longer offered.
e Section 2.3.2 updated to include Content Management Service.
e Section 3.1 updated, mainly regarding post-installation steps.
e New section 4.1.3.4 Data Growth and Archiving Monitors.
e Section 5.3.1 updated regarding technical users (service user for access to at-
tachments).
e Section 5.7 deleted, since not relevant.
31 2014-08-14 RTC of SPO5
e Section 3.1, paragraph Post Installation: Two more services listed that need to
be activated in transaction SICF.
® New section 5.7 Data Protection.
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Version Date Description
4.0 2015-03-27 RTC of SPO7 (Feature Pack 3)
Several document changes, mainly related to new SPO7 features, for example:
® Section 3.1, paragraph Post Installation: Five more services listed that need to
be activated in transaction s1cF
e Section 4 (Operation Information):
o Update of links to SAP NetWeaver documentation and to SAP Support Por-
tal
o Section 4.1.3: Correction of sub-section numbering
o Section4.1.3.3
o New application log object /IAM/NOTIFICATION
o New application log subobject DATE DETERMINATION for ob-
ject /IAM/COMMON
o Section 4.1.3.4: Additional workflow events related to reminders and sub-
scriptions (watch list entries)
e Section 5 (Security Information):
o Update of links to SAP NetWeaver Security Guide
o Section 5.4: New authorization objects related to new user status fields
and to reminders and subscriptions
o Section 5.8: Update concerning historical texts and change documents
4.1 2015-06-12 Section 5.7: Update concerning Reported By field
4.2 2016-06-27 Section 2.2: Update concerning the use of SAP QIM with SAP S/4HANA
4.3 2017-01-20 Section 2.2: Update concerning the use of SAP QIM with SAP S/4HANA in a side-by-
side scenario
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Getting Started

11 About This Document

Use

This Administrator’s Guide is the central starting point for the technical implementation of SAP Quality Issue
Management.

Use this Guide to get an overview of SAP Quality Issue Management, its software units, and its scenarios from a
technical perspective. The Administrator's Guide is a planning tool that helps you to design your system
landscape. It refers you to the required detailed documentation.

The Administrator’s Guide is a single source of information to support the implementation and operation of SAP
Quality Issue Management. Therefore, it includes the following information:

Planning Information

The first chapters of the Administrator’'s Guide provide you with overview information about SAP Quality Issue
Management including its software units and the system landscape.

Installation Information

This chapter gives you an overview of the installation components and the sequence in which they are
installed.

Operation Information

This chapter provides you with the information that you require to operate SAP Quality Issue Management.
Security Information

This chapter provides you with the information that you require to operate SAP Quality Issue Management
securely.

Constraints

The business scenarios that are presented here serve as examples of how you can use SAP software in your
company. The business scenarios are only intended as models and do not necessarily run the way they are
described here in your customer-specific system landscape. Ensure to check your requirements and systems
to determine whether these scenarios can be used productively at your site. Furthermore, we recommend
that you test these scenarios thoroughly in your test systems to ensure they are complete and free of errors
before going live.

This Administrator’s Guide primarily discusses the overall technical implementation of SAP Quality Issue
Management, rather than its subordinate components. This means that additional software dependencies
might exist without being mentioned explicitly in this document. You can find more information about
component-specific software dependencies in the corresponding installation guides.

SAP Quality Issue Management
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1 Note

You can find the most current information about the technical implementation of SAP Quality Issue
Management and the latest guides on SAP Service Marketplace at http://service.sap.com/instguides /.

We strongly recommend that you use the documents available here. The guides are regularly updated.

1.2 Related Information

1.2.1 Planning Information

For more information about planning topics not covered in this guide, see the following content on SAP Service

Marketplace or SAP Help Portal:

Table 2:

Content

Latest versions of installation and upgrade guides

Location on SAP Service Marketplace

http://service.sap.com/instguides

SAP Business Maps — information about applications and
business scenarios

http://service.sap.com/businessmaps

General information about SAP Quality Issue Management

http://help.sap.com/gim

disk and memory resource — with the Quick Sizer tool

Sizing, calculation of hardware requirements — such as CPU,

http://service.sap.com/quicksizer i

Released platforms and technology-related topics such as
maintenance strategies and language support

http://service.sap.com/platforms&r

To access the Platform Availablity Matrix directly, enter

http://service.sap.com/pamPfir.

Network security

http://service.sap.com/securityguide P

High availability

http://www.sdn.sap.com/irj/sdn/ha®

Performance

http://service.sap.com/performance

Information about Support Package Stacks, latest software
versions and patch level requirements

http://service.sap.com/sp-stacks

Information about Unicode technology

http://www.sdn.sap.com/irj/sdn/il8n

SAP Quiality Issue Management
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http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/instguides
http://help.sap.com/disclaimer?site=http://service.sap.com/businessmaps
http://help.sap.com/qim
http://help.sap.com/disclaimer?site=http://service.sap.com/quicksizer
http://help.sap.com/disclaimer?site=http://service.sap.com/platforms
http://help.sap.com/disclaimer?site=http://service.sap.com/pam
http://help.sap.com/disclaimer?site=http://service.sap.com/securityguide
http://help.sap.com/disclaimer?site=http://www.sdn.sap.com/irj/sdn/ha
http://help.sap.com/disclaimer?site=http://service.sap.com/performance
http://help.sap.com/disclaimer?site=http://service.sap.com/sp-stacks
http://help.sap.com/disclaimer?site=http://www.sdn.sap.com/irj/sdn/i18n

1.2.2 Further Useful Links

The following table lists further useful links on SAP Service Marketplace:

Table 3:
Content Location on SAP Service Marketplace
Information about creating error messages (incidents) http://service.sap.com/messagefh’
SAP Notes search http://service.sap.com/notes i

SAP Software Distribution Center (software download and or- | http://service.sap.com/swdcP
dering of software)

SAP Online Knowledge Products (OKPs) - role-specific Learn- | http://service.sap.com/rkt
ing Maps

1.2.3 Related Master Guides

This Guide is based on Component Master Guides. You can find more information about the relevant applications
in the following documents:

Table 4:
Title Location
SAP Enhancement Package 1 for SAP NetWeaver 7.3 http://service.sap.com/installNW73#%
SAP Enhancement Package 3 for SAP NetWeaver 7.0 http://service.sap.com/installNW70 #r

1.3 Important SAP Notes

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent
information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find under http://
support.sap.com/notes .

Table 5:

SAP Note Number Description

1651318/ Overview: Notes on Add-On SAP Quality | Release planning information
Issue Management

SAP Quiality Issue Management
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‘ Title

SAP Note Number Description

16535290 Overview: Notes on Add-On SAP Issue Release planning information
and Activity Management

1673333/ SAP Quality Issue Management 1.0: Re- | Contains information and references to
lease Information Note (RIN) SAP Notes for applying support package

(SP) stacks and notes

1648247 M Release strategy for SAP Quality Issue Release planning information
Management

1640939 ¢ Release strategy for SAP Issue and Release planning information
Activity Management

1651252 e Installation of Add-On SAP Quality Issue | Installation information
Management 100

1757913 Support Packages for QAM 100 Upgrade information

1653502 P Installation of Add-On SAP Issue and Installation information
Activity Management 100

1757914 ¥ Support Packages for IAM 100 Upgrade information

1 Note

As of software provisioning manager 1.0 SPO7 (SL Toolset 1.0 SP12), the term “product instance” replaces the
term “usage type"” for SAP systems based on SAP NetWeaver 7.3 including enhancement package 1 and
higher. Note that there is no terminology change for older releases and the mentioned terms can be used as

synonymes.

SAP Quality Issue Management
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2 SAP Quality Issue Management Overview

With SAP Quality Issue Management, a modern and flexible tool is provided in order to cover issue handling of all
kinds and for all industries. It enables an easy tracking and analysis of issues and related activities — also across
systems and applications. Furthermore, SAP Quality Issue Management supports integrated scenarios by
triggering issues from other applications, linking issues with processes in connected applications, or even by
initiating follow-up actions in connected systems during the course of an issue resolution.

Typical Scenario Description

It starts typically with the issue reporter, who detects the issue. This person may not even have access to a
system. He or she reports it to an issue submitter who can enter the given information into the SAP Quality Issue
Management system.

The issue will be forwarded to the so-called issue driver as the responsible person for a given issue. They would
typically check the original information and enrich it by adding further data that can be identified; for example,
more concrete reference information, such as recent deliveries, mails related to the issue, and so on. In addition,
the issue driver can trigger an initial root-cause analysis, for example, by responding to a list of questions assigned
to the issue as activities.

The issue driver can also define the responsible activity drivers, who can be assigned to different departments and
business areas, for example, Quality Management, Sales, Purchasing and so on, where the different activities
need to be defined.

The activity drivers assign the appropriate activities and forward them to different activity processors, who then
take action and execute the given activities.

After completion, the issue driver validates the results; for example, they check whether the taken actions have
been sufficient to solve the issue or not. If yes, they can complete the issue and also do a final validation as an
effectiveness check.

2.1 Software Units of SAP Quality Issue Management

SAP Quality Issue Management 1.0 can be based on SAP NetWeaver 7.3 enhancement package 1 or SAP
NetWeaver 7.0 enhancement package 3. The detailed software units required are as follows:

Table 6:
Type of Component Component
Software Component SAP_BASIS 731 (including NWBC)
Software Component SAP_BW 731

SAP Quality Issue Management
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Type of Component Component
Software Component SAP_ABA 731
Software Component PI_BASIS 731
Software Component MDG_FND 731
Software Component SAP_BS_FND 731
Software Component WEBCUIF 731
Software Component IAM 100
Software Component QAM 100
Additional Component Adobe Document Services
Additional Component TREX

1 Note

As of SPO3, SAP Quality Issue Management 1.0 can also be installed on SAP NetWeaver AS ABAP 7.4 (see SAP
Note 1826531), or on SAP NetWeaver AS ABAP 7.4 for Suite on HANA (see SAP Note 1812713).

2.2 Software Component Matrix

This section provides an overview of which deployment scenario of SAP Quality Issues Management (SAP QIM)
uses which software unit.

For the latest component version and patch level requirements, see http://service.sap.com/sp-stacks .
Deployment Scenarios
There are three deployment scenarios for SAP QIM, and your installation depends on which scenario you choose.

You can use SAP QIM in the following scenarios:

1. Standalone: SAP QIM as a standalone solution

2. Add-on: SAP QIM as a complementary solution to an existing system, for example, SAP ERP
In this variant, SAP QIM and SAP ERP run on the same system. You can use the master and organizational
data base of SAP ERP.

1 Note

SAP QIM cannot be installed on top of an SAP S/4HANA system. This also means that you cannot convert
an SAP ERP system to an SAP S/4HANA system if SAP QIM is installed. You need to uninstall SAP QIM
first.

SAP Quality Issue Management
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3. Side-by-side with SAP ERP or SAP S/4HANA: SAP QIM as a standalone solution parallel to an existing
system
In this variant, SAP QIM and SAP ERP or SAP S/4HANA run on separate systems. The systems communicate
via RFC connections or services.

Table 7: Software Component Matrix

Deploy- SAP QIM SAP BS SAP Net- SAP ERP SAP ERP 6 | SAP SAP Solu-
ment Sce- FND 731 Weaver AS |4.6C inclEHP 6 | S/4HANA | tion Man-
nario ABAP 731 on-premise | ager
SAPQIMas | X X X X - - - X
a stand-
alone sys-
tem
SAP QIM X X X X X X) X) X

ide-by-
side-by minimal full scope*
side *

scope

SAPQIMas X X X X (X)** (X)** - X
add-on

Key: X = mandatory (X) = optional

* For more information, see SAP Library for SAP QIM under http://help.sap.com/qim100 [ Application Help
Use of SAP QIM » Connection of Systems in a Side-by-Side Scenario 3.

** As a prerequisite, the SAP ERP system must at least be based on SAP NetWeaver AS ABAP 731.

2.3 System Landscape

The following section describes various ways in which the system landscape can be set up.

2.3.1 Minimal System Landscape

Use

The following figure provides an overview of a minimal system landscape in SAP Quality Issue Management.

SAP Quiality Issue Management
12 CUSTOMER SAP Quality Issue Management Overview


http://help.sap.com/qim100

Qim 1.0 Clients

Minimal System Landscape
(incl. ADS) %

+ HTTP
SAP Solution Management SAP Business Suite SAP NetWeaver
SAP Solution Manager SAP QIM 1.0 ADS
ABAP Server J2EE Setver
ABAP Server J2EE Server
Mairenance I QM 1.0 |
Cptimaar §
{' Adcba Documant
’ 1AM 1.0 ] Server [ADS)
? 2
I SAP BS Foundation 7.31 | | WEBCUIF 7.31 I
| WEB AS ABAP 711 I
1t 1t Database
Database ( )
Figure 1: Minimal System Landscape
Components

The minimal system landscape involves SAP Quality Issue Management, Adobe Document Services (ADS), and
SAP Solution Manager.

SAP Quality Issue Managements consist of the following software components:

e QAM (Application Component CA-IAM-QIM)
This component runs the Ul configurations and worklists. It sits above the IAM engine.

e |AM (Application Component CA-IAM-ENG)
The IAM engine is how SAP runs Quality Issue Management. It covers the generic engine for the application.

ADS is needed for printing (see also section Prerequisites.
SAP Solution Manager is useful for installing IAM and connecting to different systems.
Communication Between Back and Front Ends

The communication between back end and front end is HTTP. The applications are accessed from the front end
by using SAP NetWeaver Business Client (NWBC). The applications can also be called using SAP NWBC for
HTML, a lighter version of NWBC with zero footprint.

Communication with Other SAP Systems

You can communicate with other Suite systems using remote function calls (RFCs).

Prerequisites
The SAP Quality Issue Management system needs SAP NetWeaver Application Server ABAP 7.31, SAP_BS_FND

7.31, and WEBCUIF 7.31.

You need Adobe Document Services (ADS) if you want to print documents such as issue reports. For more
information, see SAP NetWeaver Library under Configuration of Adobe Document Services for Print Applications.

SAP Quality Issue Management
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1 Note

ADS does not need to be installed on the same system as SAP QIM. ADS is a service, which has to runin a Java
stack. The Java stack can run on the QIM server, on a separate server, or on Solution Manager. When printing
mass data, the performance of a productive system can be slowed down.

ADS cannot be installed on an ABAP stack.

2.3.2 Maximal System Landscape

The following figure shows an overview of the maximal system landscape.

QIm 1.0 Clienls
Full System Landscape
(incl. optional components)

SAP Solution Manager
SAP Solution Manager

ABAP Server J2EE Server
[+}

arq) oD{
Portal, ADS, BI “,,,~BI Reporting (Hub) )
[

J2EE Server ABAP Server JZEE Sarver

& n » AP NetWeaver
R3 Rel. 4.6C - ERP EhP6

ABAP Server

Solusian

Manager 7.0 3
B
ABAP 7,02 Java 702

WEB AS
JAVA T 02

LY 4 F

( Databasa )

| Businass Packages |

[
EP Goro
[
WEB AS Java 7.02

( Databasa )

SAP Business Suite Q,%
2N |C e )

SAP QIM 1.0/ SAP ERP EhP6 O Business Obiects
ABAP Sarver

| am 1o | TREX ™ ; BOE Server O‘Odb,?e

{, ECC 608 C,Cs C, 4+, Java ’
[ 1AM 1.0 |
: : ; =]
[ WEBCUWF 7.31 | I SAP 0BS Foundation 7.31 |
]
‘ WEB AS ABAF T.31 |
It T

( ooine ) il =

Figure 2: Full System Landscape

Additional Components (compared to Minimal System Landscape)

TREX

The Search and Classification Engine (TREX) runs on a separate server. It supports the search for issues and
activities with SAP Enterprise Search.

SAP Quality Issue Management
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SAP NetWeaver Business Warehouse Accelerator

This powers business intelligence (BI), which helps manage and track issues.

Business Intelligence (BI)

This gives you the insight necessary to monitor, manage, and track various quality issues and follow-up actions.
Enterprise Portal

SAP Enterprise Portal can be used to access applications from the front end. If you want to use SAP Enterprise
Portal as a Ul, you need to generate a portal role. You do this by uploading the delivered QIM NWBC role to SAP
Enterprise Portal, using a role upload tool. The role upload tool is available as of the SAP Enterprise Portal
releases listed in SAP note 1685257. For more information, see the SAP QIM documentation at http://

help.sap.com/qim100| Application Help # Roles in SAP Quality Issue Management » Generation of Portal
Roles 3.

BusinessObjects Enterprise (BOE)

This platform powers the tools for reporting, query and analysis, and performance management — which helps
track and control quality issues and activities.

Content Management Service (CMS)

This component of Knowledge Provider (KPro) can be used for storing attachments.

2.3.3 Typical System Landscape

The following figure shows a typical system landscape.

SAP Quality Issue Management
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SAP Solution Management SAP Business Suite

C owmon

Figure 3: Typical System Landscape

Features

Within a typical system landscape, you do not need a separate system for SAP Quality Issue Management. Instead
you can install it on any Suite system — preferably on SAP ERP with SAP NetWeaver AS ABAP 7.31 underneath.

Components

SAP Quality Issue Management uses Adobe printing for the printouts — this needs the ADS. Finally, you should use
SAP Solution Manager to drive the installation.

2.4 Business Processes of SAP Quality Issue Management

A quality issue management scenario typically consists of the following processes:
Capturing and Processing Issues

1. Createanissue
2. Manage and coordinate an issue
3. Analyze individual defects and causes

SAP Quiality Issue Management
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Analyze related issues
Assign and coordinate activities
Validate and complete anissue

N o ok

Archive issues

Conducting an 8D Problem Analysis

1. Trigger problem analysis
2. Process problem analysis
3. Print 8D report

Processing Activities Related to an Issue

Process an activity

Trigger follow-up actions

Check effectiveness of a measure
Confirm an activity

s W

Archive activities

Monitoring and Coordinating Issues and Activities
1. Monitor issues across multiple sources

2. Monitor activities across multiple sources
3. Perform mass processing of issues and activities

Analyzing Issues and Activities

1. Define KPIs for issues and activities

2. Use adashboard for issue and activity analysis
3. Create areport at enterprise level

4. Analyze trends

For more information, see the documentation in SAP Solution Manager under

Quality Issue Management » Scenarios » SAP Quality Issue Management

SAP Quality Issue Management
SAP Quality Issue Management Overview
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3 Installation Information

3.1 Overall Implementation Sequence

This section describes the implementation sequence for SAP Quality Issue Management. The first two deployment
scenarios are installed in the same way.

1 Note

For the latest component version and patch level requirements, as well as more detailed information about the
installation process for SAP Quality Issue Management, see the Notes mentioned below.

Notes

e [nstallation note software component IAM: 1653502 #r
e [nstallation note software component QAM: 1651252
e SAP Quality Issue Management: Release Information Note (RIN): 1673333

Installation Sequence

SAP QIM Standalone and SAP QIM Side-By-Side with SAP ERP

Install (or update) SAP NW AS ABAP 731

Install IAM 100 layer

Install QAM 100

4. Install SAP NetWeaver Business Client (NWBC) for Desktop (optional)

W

SAP QIM on ERP

Install (or update) SAP NW AS ABAP 731

Install (or update) SAP ERP (best integration as of ERP 6.0 EHP 6)
Install IAM 100 layer

Install QAM 100

5. Install NWBC for Desktop (optional)

AW

If you want to use NWBC for Desktop (instead of or in addition to) NWBC for HMTL, a client setup is necessary.
You should download the latest version of NWBC for desktop, and then uninstall the old version before installing
the new version. For more information about NWBC for Desktop, see the SAP NetWeaver Business Client

documentation http://help.sap.com/nw731|s SAP NetWeaver Library: Function-Oriented View ¥ Application
Server » Application Server ABAP » Ul Technologies in ABAP » SAP NetWeaver Business Client 4.

Post-Installation

1. You must manually activate the following services as follows after the installation. Otherwise the error
message Service cannot be reached is displayed.

1. Choose transaction sICF.
2. Under Hierarchy Type, enter SERVICE and execute.

SAP Quality Issue Management
18 CUSTOMER Installation Information


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1653502
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1651252
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1673333
http://help.sap.com/nw731

3. Navigate to the applications via the path | default_host ¥ sap # bc » webdynpro ¥ sap 3 and activate the

following services:

O QAM CATEGORY INFO

© QIM ACT ID LINK CAT
© QIM GAF ISSUE CRT

© QIM GQIA POWL OVP

© QIM MANAGE REMINDERS
© QIM MANAGE WATCH LISTS
© QIM OVP ACTIVITY

© QIM OVP_ISSUE

© QIM OVP_ISSUE CRT

0 QIM OVP_NOTIFIER

0 QIM SUBISSUE ID

© WDR _CHIP PAGE

© IBO_WDR_INBOX

© FDT_WD WORKBENCH

2. Inaddition, you need to make the following settings in transaction SICF:

1. For the navigation and usage of the NWBC for HTML you need to activate the service NwBC (path:
default host/sap/bc/).

2. If you use attachments in QIM, you need to activate the service CONTENTSERVER (path:
default host/sap/bc/). Inthe CONTENTSERVER settings you need to assign a user for anonymous
access with user type Service, created in transaction su01. Do not assign any permissions to this user.

3. If you use SAP Business Workflow, you need to activate the service WEBGUT (path:
default host/sap/bc/gui/sap/its/).Inthe WEBGUI settings, the GUI Link needs to be specified
with Yes.

4. You need to activate the service MIMES (path: default host/sap/public/bc/its/). Inthe MIMES
settings, the GUI Link must not be specified.

3. Intransaction sSE80, you need to publish the Internet Services SYSTEM and WEBGUT on the INTERNAL site.

4. Delivery Customizing is imported into client 000 and may have to be copied to other clients. For more
information, see SAP Note 337623 .

5. If you want to use SAP Enterprise Portal as a Ul, you need to generate a portal role. You do this by uploading
the delivered QIM NWBC role to SAP Enterprise Portal, using a role upload tool. The role upload tool is
available as of the SAP Enterprise Portal releases listed in SAP Note 1685257 # . For more information, see
the SAP QIM documentation at http://help.sap.com/qim100l Application Help # Roles in SAP Quality Issue

Management » Generation of Portal Roles 3.
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4 Operation Information

4.1 Monitoring of SAP Quality Issue Management

Within the management of SAP technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

You can find more information about the underlying technology in the SAP NetWeaver Administrator's Guide —
Technical Operations Manual in the SAP Library under SAP NetWeaver Library.

4.1.1 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP Quality Issue Management 1.0 as quickly as possible.

SAP Quality Issue Management 1.0 does not offer specific data in the Computer Center Management System
(CCMS) for alert monitoring. Nevertheless general monitoring options can be used.

For information and detailed procedures related to SAP NetWeaver 7.0/7.3 alert monitoring, see the Monitoring
Setup Guide for SAP NetWeaver at http://service.sap.com/operationsNW70# and the Technical Operations
Manual for SAP NetWeaver in http://help.sap.com/nw731| System Administration and Maintenance Information
» Technical Operations for SAP NetWeaver » Administration of Application Server ABAP » Monitoring and
Administration Tools for Application Server ABAP 1.

4.1.2 Monitoring Installation and Setup

There are no additional steps besides the ones described in the installation guide to setup SAP Quality Issue
Management monitoring.

In order to enable the auto-alert mechanism of CCMS, see SAP Note 617547 #r.
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4.1.3 Detailed Monitoring and Tools for Problem and
Performance Analysis

4131 BRFplus Traces

SAP Quality Issue Management supports the use of SAP Business Rules Framework plus (BRFplus) to:

e Determine business partners for issues and activities

e Determine additional activities for issues

e Find experts for certain activities

e Determine dates for issues and activites and traffic light icons in the issue hierarchy

It is not recommended to activate these BRFplus traces for long periods of time as they are performance critical.
Trace data can be found in the BRFplus Workbench as follows:
Start transaction BRFplus to open the BRFplus Workbench.

Switch to expert mode by choosing [ Personalize # User Mode » Expert 3.
In the Tools menu choose Lean Trace.

Find/name the required BRFplus function using the given selection data.
Start the search to see any trace data if available.

ok~ w o=

413.2 Trace and Log Files

Trace files and log files are essential for analyzing problems.

The standard SAP NetWeaver tools such as transactions sT22 (Run Time Errors) and sM21 (System Log) can be
used to monitor trace and log files. For more information, see the Technical Operations Manual for SAP

NetWeaver under: http://help.sap.com/nw731|p System Administration and Maintenance Information »
Technical Operations for SAP NetWeaver » Administration of Application Server ABAP » Monitoring and
Administration Tools for Application Server ABAP » Trace Functions 4 and System Log.

4.1.3.3 Application Logs

SAP Quality Issue Management uses the application log (part of SAP NetWeaver) to store error, warning, and
success messages issued in critical processes or in Ul transactions.

For general information about application logs, see http://help.sap.com/nw731| Application Help ¥ Function-
Oriented View » Solution Life Cycle Management » Application Log (BC-SRV-BAL) 3.

The following application log entities hold entries of relevance for SAP Quality Issue Management and can be
monitored with transaction SLG1:

Object /IAM/COMMON
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Messages related to entities located in the IAM layer:

Subobject CATEGORY

Messages resulting from access to reference objects using certain object categories. Activities and issues
have object references with categories defined in the IAM layer. See, for example, MAT_ERP, BAT_ERP.
Subobject DATE_DETERMINATION

Messages resulting from the execution of the date determination for an issue and its subordinated activities.
Subobject FOLLOWUP

Messages resulting from the execution of follow-up actions (activities) in issue processing.

Subobject GTYPE_ACCESS

Messages resulting from the access to reference objects using certain object types. Issues and activities
have object references with object types defined in the IAM layer. See, for example, BAT (Batch), CUS
(Customer), DLI (Outbound Delivery Item).

Subobject METHOD

Messages resulting from the execution of actions for reference objects. Activities and issues could have
object references where actions are performed.

Object QAM_COMMON

Messages related to objects located in the QIM layer:

Subobject CATEGORY

Messages resulting from access to object categories in the QIM worklists for activities and issues. For
example, QA_AUD (Audit), QA_FMEA (FMEA), QA_QA (QAM Activity), QI_QI (QAM Issues), QI_QI_DF (QAM
Defects), QI_QMNO (Quality Notification).

Subobject CUSTWIZARD

Messages resulting from QIM customizing wizards.

Subobject GQI_ACCESS

Messages resulting from access to generic quality issues.

Subobject GQA_ACCESS

Messages resulting from access to generic quality activities.

Subobject GTYPE_ACCESS

Messages resulting from the access to reference objects of issues and activities in issue and activity
processing, having types defined in the QIM layer. See, for example, | (generic quality issue), A (Quality
Activity).

Subobject METHOD

Messages resulting from the execution of actions for items in the generic issue and activity worklist.

Object CDSG1

Messages related to digital signatures:

Subobject /IAM/ISS
Messages related to the digital signature of business transactions concerning issues.

Subobject /IAM/ACT
Messages related to the digital signature of business transactions concerning activities.

Object /IAM/NOTIFICATION

22

Subobject REMINDERS
Messages related to the sending of reminder notifications

Subobject SUBSCRIPTIONS
Messages related to the sending of subscription notifications
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In addition, the following specific trace and log tools are available:

Table &:

Monitoring Object | Monitor Transac-

tion/ Tool

Frequency

Indicator or Error

Monitoring Activ-

ity or Error Han-

dling Procedure

Who

Message Logs for
Issue Objects in
QIM Worklists
(POWL)

I sap
Customizing
Implementation

Guide > Cross-
Application
Components ¥
Quality Issue

Management >
Worklists for
Quality Issues and

Activities » Define
Access to Quality

Issues 1

or

|} Work Center
“System

Administration” >
Communication
with External

Systems ¥ Monitor
Access to Issue

Worklist ]

Check frequently
(daily, weekly)

Check for red traf-
fic light/ status (er-
ror messages in
log)

Application Log/
Message List per
Object Category,

Basis

Support
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Monitoring Object

Monitor Transac-
tion/ Tool

Frequency

Indicator or Error

Monitoring Activ-

ity or Error Han-

dling Procedure

Who

Components >
Quality Issue

Management >
Worklists for
Quality Issues and

Activities > Define
Access to Quality

Activities 3

or

| Work Center
“System

Administration” >
Communication
with External

Systems » Monitor
Access to Activity

Worklist 3

Message Logs for b sapP Check frequently Check for red traf- | Application Log/ Basis
Activity Ob.jects in Customizing (daily, weekly) fic light/ statu§ (er- Me.ssage List per Support
QIM Worklists Implementation ror messages in Object Category,
POWL lo
( ) Guide > Cross- g)
Application

41.3.4 Workflow Event Queues and Traces

SAP Quality Issue Management triggers SAP business workflow events. In order to monitor them and to find and
analyze any problems related to such events, the tools for SAP business workflow event queue administration
(transaction sWEQADM) and browsing can be used. The events related to SAP Quality Issue Management should be
listed with the following object IDs.

For events related to issues:

® /IAM/CL ISSUE WF CONNECT
® CL OAM ISSUE WF CONNECT

For events related to activities:

® /IAM/CL ACTIVITY WF CONNECT
® CL OAM ACTIVITY WF CONNECT
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For events related to watch list and reminders:

® /IAM/CL NOTIFIER WF CONNECT
® CL OAM NOTIFIER WF_CONNECT

4135 Data Growth and Data Archiving Monitors

The following tables are the top five fastest growing tables in SAP QIM:

e /IAM/D I ROOT

® /IAM/D I PARTY

e /IAM/D I OBJ REF
® /IAM/D ACT PARTY
e /IAM/D ACT ROOT

You can archive the data of these tables in Archive Administration (transaction SARA), using the following
archiving objects:

e /1aM/ACT for QIM activities
e /IAM/ISSUE for QIM issues

4.2 Management of SAP Quality Issue Management

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

Additional information can be found in SAP Solution Manager documentation on SAP Help Portal at http://
help.sap.comll Application Lifecycle Management » SAP Solution Manager 3

You can find more information about the underlying technology in the Technical Operations Manual under http://

help.sap.com/nw731| System Administration and Maintenance Information 4.

4.2.1 Starting and Stopping

The stop sequence is in reverse order to the start sequence.

Table 9: Start and Stop Sequences and Tools

Software Component Sequence Comments

SAPNW7.31 1 STARTSAP / STOPSAP
(Unix) SAPMMC (Windows)
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Software Component Sequence Tool Comments
SAP BS_FND 2 STARTSAP / STOPSAP
(Unix) SAPMMC (Windows)
SAP ERP 6.0 EHP3 3 STARTSAP / STOPSAP Only if QIM is running as an
(Unix) SAPMMC (Windows) add-on otherwise it's inde-
pendent from the rest
QIM/IAM ABAP Server 4 STARTSAP / STOPSAP
(Unix) SAPMMC (Windows)
AS Java* 5 Depending on the system Required for Adobe ADS
landscape

For more information about STARTSAP/STOPSAP and SAPMMC, see http://help.sap.com/nw731| Application
Help ¥ Function-Oriented View ¥ Soluction Life Cycle Management  Starting and Stopping SAP Systems Based
on SAP NetWeaver 3.

*Starting and Stopping Application Server Java

If you want to print from SAP Quality Issue Management, you have to be able to start/stop the Application Server
Java (AS Java, formerly known as J2EE Engine). Depending on your operating system and how you installed the
AS Java in your system landscape, different procedures apply.

For detailed documentation about starting and stopping the AS Java, see http://help.sap.com/nw731

| Application Help ¥ Function-Oriented View ¥ Application Server  Application Server Java (AS Java) ¥

Administering Application Server Java ¥ Administration  The Startup Framework for AS Java 3.

4.2.2 Software Configuration

This chapter explains which components or scenarios used by this application are configurable and which tools
are available for adjusting.

The Implementation Guide (IMG) is the standard SAP tool for component Customizing. To display the
Implementation Guide (IMG) on the SAP Easy Access screen choose | Tools  Customizing # IMG ¥ Execute
Project 3 (transaction SPRO).

Customizing settings for SAP Quality Issue Management can be found under | Cross-Application Components

Quality Issue Management 3.

Also, see detailed configuration settings in the SAP Quality Issue Management section of SAP Solution Manager.
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4.2.3 Administration Tools

Most of the SAP Quality Issue Management tools are based on SAP NetWeaver AS ABAP 7.31. For more
information, see http://help.sap.com/nw731|r Application Help  SAP Library ¥ Function-Oriented View ¥
Application Server » Application Server ABAP » Administration of Application Server ABAP 3.

4.2.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure.

The backup and restore strategy for SAP Quality Issue Management consists of two parts:
e Backup and restore coverage for each component

e (Cross-system data dependencies and handling

The backup and restore strategy for your system landscape should not only consider SAP systems but should
also be embedded in overall business requirements and incorporate your company’s entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as the loss of a data
center through fire. It is most important in this context that you ensure that backup devices are not lost together
with normal data storage (separation of storage locations).

Based on the type of application data contained in a component, a categorization scheme for system components
can be used to analyze the backup requirements of any system component and to easily determine an
appropriate backup method for this component.

For more information, see:

e SAP NetWeaver documentation under http://help.sap.com/nw731| Application Help » SAP Library
Function-Oriented View ¥ Solution Life Cycle Management % Backup and Recovery 3

e Best practices document Backup and Restore under http://service.sap.com/bp-roadmap#|# Technical
operations # Backup and Restore for SAP System Landscapes 4

4.3 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

4.3.1 Transport and Change Management

All components of SAP Quality Issue Management are client-enabled. For transport and change management
issues, the procedures of SAP NetWeaver apply. For more information, see http://help.sap.com/nw731
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| Application Help ¥ SAP Library ¥ Function-Oriented View  Application Server » Application Server ABAP j»
Administration of Application Server ABAP » Change and Transport System 3.

4.3.2 Support Packages and Patch Implementation

We recommend that you implement Support Package Stacks (SP Stacks), which are sets of support packages
and patches for the respective product version that must be used in the given combination. The technology for
applying support packages and patches will not change.

Read the corresponding Release and Information Notes (RIN) (SAP Note 1673333 for SAP QIM) before you
apply any support packages or patches of the selected SP Stack. Use the Maintenance Optimizer (transaction
DSWP) of the SAP Solution Manager to select, download, and install the needed software components and
required support packages. For more information, see the following:

® SAP Solution Manager documentation on SAP Help Portal at http://help.sap.coml|l Application Lifecycle
Management » SAP Solution Manager » Application Help ¥ Maintenance Management » Maintenance
Optimizer 3

e SAP Service Marketplace at http://service.sap.com/solman-mopz#

e The documentation for transaction SAINT (SAP Add-On Installation Tool)

For more information about the implementation of support packages as well as possible side effects, see the
following:

® http://support.sap.com/patches
e http://support.sap.com/notes

4.4 Troubleshooting

4.4.1 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

4.4.2 Remote Support Setup

SAP support needs to be able to work remotely for highest efficiency and availability. Therefore all required
support tools must be remotely accessible for SAP support.
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For SAP QIM, the standard SAP procedures for setting up remote support apply. For more information about

accessing support remotely, see https://support.sap.com/#& | Remote Support 3.

For more information about setting up an HTTP connection, see SAP Note 592085#% . An HTTP connection is
required to open an NWBC application from the support system.

In SAP QIM, the standard SAP NetWeaver support roles are used to provide remote support. In addition, the
supportrole Sap_QIM SUPPORT with display authorization is available in the QIM system.

4.4.3 Problem Message Handover

For information about processing support messages (incidents) and forwarding them to SAP, see the following:

e https://support.sap.comfé|r Knowledge Base & Incidents 3
e http://help.sap.com| Application Lifecycle Management » SAP Solution Manager # IT Service

Management 3.

To send incidents to SAP, choose the appropriate component (or subcomponent) name from the SAP component
hierarchy. The following components are relevant for SAP QIM:

® CA-IAM-ENG (forissues related to the general IAM layer)
e CA-T1AM-QIM (forissues related to QIM business logic)
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5 Security Information

5.1 Before You Start

SAP QIM can be deployed as standalone solution based on SAP NetWeaver 7.0 including enhancement package 3
or SAP NetWeaver 7.3 including enhancement package 1. SAP QIM can also be connected to other applications,
for example, SAP ERP. Therefore, the corresponding Security Guides also apply to SAP QIM. Pay particular
attention to the most relevant sections or specific restrictions as indicated in the table below.

Table 10:

Component Corresponding Security Guide

SAP NetWeaver Application Server ABAP 731 http://help.sap.com/nw731|F Security Information ¥

Security Guide > Security Guides for SAP NetWeaver
Functional Units > Security Guides for the AS ABAP > SAP
NetWeaver Application Server ABAP Security Guide 4

SAP NetWeaver Identity Management Security Information http://he|p.sap.com/nw731|} SAP Library % Function-

Oriented View > Security > Identity Management ]

SAP NetWeaver Business Client http://help.sap.com/nw731|l Application Help ¥ Function-

Oriented View > Application Server > Application Server
ABAP > Ul Technologies in ABAP > SAP NetWeaver Business
Client > Security Aspects ]

SAP ERP http://service.sap.com/securityguidefblb SAP Business

Suite Applications  SAP ERP, for example, 6.0 4

For a complete list of the available SAP Security Guides, see http://service.sap.com/securityguide® on SAP
Service Marketplace.

Important SAP Notes

At the moment, there are no special SAP Notes regarding security for SAP QIM. For a list of additional security-
relevant SAP Hot News and SAP Notes, see also SAP Service Marketplace at http://service.sap.com/
securitynotes .
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5.2 Technical System Landscape

For more information about the technical system landscape, see the resources listed in the table below and the
System Landscape section above.

Table 11:
Guide/Tool Quick Link to the SAP Service Market-
place or SDN
High availability High Availability for SAP Solutions http://sdn.sap.com/irj/sdn/hafe
Technical landscape design See applicable documents http://sdn.sap.com/irj/sdn/landscape-
designir

5.3 User Administration and Authentication

SAP Quality Issue Management uses the user management and authentication mechanisms provided with the
SAP NetWeaver platform, in particular the SAP NetWeaver Application Server ABAP. Therefore, the security
recommendations and guidelines for user administration and authentication as described in the SAP NetWeaver
Application Server ABAP Security Guide apply to SAP Quality Issue Management.

In addition to these guidelines, we include information about user administration and authentication that
specifically applies to the SAP Quality Issue Management application in the following topics.

5.3.1 User Management

User management for SAP Quality Issue Management uses the mechanisms provided with the SAP NetWeaver
Application Server (ABAP), for example, tools, user types, and password policies. For more information, see

http://help.sap.com/nw731|+ Application Help » Function-Oriented View ¥ Solution Life Cycle Management »
Security and User Administration 3.

For an overview of how these mechanisms apply for SAP Quality Issue Management, see the sections below. In
addition, we provide a list of the standard users required for operating SAP Quality Issue Management.

User Administration Tools

The table below shows the tools to use for user management and user administration with SAP Quality Issue
Management.
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Table 12: User Management Tools

Tool Description

User maintenance for ABAP-based systems (transaction For more information about the authorization objects pro-

SU01) vided by SAP Quality Issue Management, see the section Au-
thorizations [page 34].

Role maintenance with the profile generator for ABAP-based | For more information about the roles provided by SAP Quality

systems (PFCG) Issue Management, see the section Authorizations [page
34].
Central User Administration (cua) for the maintenance of Use the CUA to centrally maintain users for multiple ABAP-
multiple ABAP-based systems based systems. Synchronization with a directory server is also
supported.
Report /IAM/APP CREATE BUPA This report supports you in creating business partners for the

system users, for example, that you have imported from an
external system.

User Types

Itis often necessary to specify different security policies for different types of users. For example, your policy may
specify that individual users who perform tasks interactively have to change their passwords on a regular basis,
but not those users under which background processing jobs run.

The user types that are required for the SAP Quality Issue Management include:

e |ndividual users:

o Dialog users are used for NWBC for Desktop and for RFC connections to navigate into detail views for
objects (like materials or quality notifications) located in other logical systems (used for SAP GUI for
Windows or RFC connections).

o Internet users are used for NWBC for HTML. (The same policies apply as for dialog users, but used for
Internet connections.) Moreover, these users could be used if it is intended to attach and use URLs as
attachments within QIM application.

® Technical users:

o If you use attachments in SAP Quality Issue Management, you need to assign a service user for
anonymous access in transaction sTCr in the CONTENTSERVER settings. Do not assign any permissions
to this user.

o Communication users are used for getting detailed information via RFC without dialog on objects that
SAP Quality Issue Management refers to and that are located in other systems.

o So far, no background users are used for SAP Quality Issue Management.

For more information about these user types, see User Types in the SAP NetWeaver Application Server ABAP
Security Guide.

Standard Users

The table below shows the standard users that are necessary for operating SAP Quality Issue Management.
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Table 13:

User ID

Password

Description

System where QIM is
installed and systems
QIM is connected to

<User 1>

Dialog user

You specify the initial
password during the in-
stallation.

The main users for
QIM, needed for QIM
application itself (if
NWBC for Desktop is
intended to be used)
and for navigation into
e.g. master data detail
information in the sys-
tem itself or in other
systems connected to

QIM.

System where QIM is
installed

<User 2>

Internet user

You specify the initial
password during the in-
stallation.

If it is intended to use
NWBC for HTML, then
this kind of user is
needed for the QIM ap-
plication additionally to
the dialog user.

System where QIM is
installed and systems
QIM is connected to

<User 3>

Communication user

The user ID and pass-
word are stored in the
RFC destination for the
connection.

Toread, triggered by
QIM application, detail
information e.g. on
master data in the sys-
tem itself or in other
systems connected to

QIM.

No users are delivered with SAP Quality Issue Management. You need to make sure that the users are available

when you start to configure the application.

5.3.2 User Data Synchronization

By synchronizing user data, you can reduce effort and expense in the user management of your system
landscape. Since SAP Quality Issue Management is based on SAP NetWeaver Application Server ABAP, you can
use all of the mechanisms for user synchronization in SAP NetWeaver here. For more information, see the SAP

NetWeaver AS ABAP Security Guide under http://help.sap.com/nw731|l Security Information j» Security Guide »
Security Guides for SAP NetWeaver Functional Units » Security Guides for the AS ABAP » SAP NetWeaver
Application Server ABAP Security Guide ¥ User Administration and Authentication ¥ User Data Synchronization 3.
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5.3.3 Integration into Single Sigh-On Environments

The SAP Quality Issue Management application supports the Single Sign-On (SSO) mechanisms provided by SAP
NetWeaver. Therefore, the security recommendations and guidelines for user administration and authentication
as described in the SAP NetWeaver Security Guide also apply.

The most widely-used supported mechanisms are listed below.
e Secure Network Communications (SNC)

SNC is available for user authentication and provides for an SSO environment when using the SAP GUI for
Windows or Remote Function Calls.

e SAP logon tickets

The SAP Quality Issue Management application supports the use of logon tickets for SSO when using a Web
browser as the frontend client. In this case, users can be issued a logon ticket after they have authenticated
themselves with the initial SAP system. The ticket can then be submitted to other systems (SAP or external
systems) as an authentication token. The user does not need to enter a user ID or password for authentication but
can access the system directly after the system has checked the logon ticket.

e (Client certificates

As an alternative to user authentication using a user ID and passwords, users using a Web browser as a frontend
client can also provide X.509 client certificates to use for authentication. In this case, user authentication is
performed on the Web server using the Secure Sockets Layer Protocol (SSL Protocol) and no passwords have to
be transferred. User authorizations are valid in accordance with the authorization concept in the SAP system.

For more information, about the available authentication mechanisms, see the User Authentication and Single
Sign-On chapter in the SAP NetWeaver Library.

5.4 Authorizations

The SAP Quality Issue Management application uses the authorization concept provided by the SAP NetWeaver
AS ABAP. Therefore, the recommendations and guidelines for authorizations as described in the SAP NetWeaver
AS ABAP Security Guide also apply to the SAP Quality Issue Management application.

The SAP NetWeaver authorization concept is based on assigning authorizations to users based on roles. For role
maintenance, use the profile generator (transaction PFCG) on the AS ABAP.

Standard Roles

The table below shows the standard PFCG roles that are used by the SAP Quality Issue Management application.
The authorization objects for these roles are supplied by SAP in the profiles.

Table 14:

Description

SAP_QIM COORDINATOR SAP Quality Issue Management Coordinator, coordinating is-
sues and performing some system administration tasks
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Role

SAP_QIM ISSUE_DRIVER

Description

SAP Quality Issue Management Issue Driver, responsible for
anissue

SAP QIM SUPPORT

Display or read-only authorization for support purposes only

SAP QIM WF

SAP Quality Issue Management Workflow authorizations
(batch)

SAP_BC_FDT_ADMINISTRATOR

BRFplus Administrator

SAP BCV_ADMIN2

Business Context Viewer Administrator

SAP_BCV_USER

Business Context Viewer User

SAP MDG_ADMIN

Master Data Governance: Administrator

SAP BC_SRV_ASF AT ADMIN

Audit Trail (ILM): Administrator

SAP BC SRV ASF AT USER

Audit Trail (ILM): Minimum Authorization for Evaluation of Au-
dit Trail Data

SAP _ESH LOCAL ADMIN

Embedded Search (Composite): Administration and Monitor-
ing

For authorizations concerning digital signatures, no PFCG roles are delivered. The relevant authorizations are
controlled with the authorization objects C_SIGNand C_SIGN BGR.

Authorization Objects

The table below shows the authorization objects that are delivered the SAP Quality Issue Management application.

Table 15:

Authorization Object

Description

IAM CAT AC Authorization to Restrict Access to SAP Quality Issue Manage-
ment Worklist Object

/IAM/IAUTH Authorization Object for Issue

/IAM/AAUTH Authorization Object for Activity

/IAM/ATTMT Authorization Object for Attachments for Issue/Activity

/IAM/OREF Authorization Object for Reference Objects for Issue and Activ-

ity

/IAM/A_ATTR

Authorization Object for Attribute Maintenance for Activity

IAM CODEGR

Authorization Object for Code Groups
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Authorization Object Description

/IAM/TXTTY Authorization Object for Descriptions

IAM/A STAT Authorization Object for Lifecycle Status (Activity)
IAM/I STAT Authorization Object for Lifecycle Status (Issue)
IAM/A RLCD Authorization Object for Role Codes in Activity

IAM/I RLCD Authorization Object for Role Codes in Issue
/IAM/CODGR Authorization Object for Selection of Code Groups/Codes
IAM/I USTA Authorization Object for User Status Action (Issue)
IAM/A USTA Authorization Object for User Status Action (Activity)
/IAM/REMIN Authorization Object for Reminders

/IAM/SUBSC Authorization Object for Subscriptions

With the Business Add-In (Badl) /1AM/BADI_ISSUE AUTHORITY you can dynamically extend the authorization of
a user. This means, for example, you can grant authorization to display or change individual objects to a user who
actually does not have this authorization in SAP QIM.

5.5 Session Security Protection

To increase security and prevent access to the SAP logon ticket and security session cookie(s), it is
recommended that you activate secure session management. We also highly recommend using SSL to protect
the network communications where these security-relevant cookies are transferred.

Session Security Protection on the AS ABAP

The following section is relevant for SAP QIM in SAP NetWeaver Business Client: To prevent access in javascript
or plug-ins to the SAP logon ticket and security session cookies (SAP_SESSIONID_<sid>_<client>). You can
activate secure session management. With an existing security session, users can then start applications that
require a user logon without logging on again. When a security session is ended, the system also ends all
applications that are linked to this security session.
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Use the transaction SICF_SESSIONS to specify the following parameter values shown in the table below in your
AS ABAP system:

Table 16: Session Security Protection Profile Parameters

Profile Parameter Recommended Value Comment
icf/set_HTTPonly_flag_on_cookies 0 Client-dependent
login/ticket_only_by_https 1 Not client-dependent

5.6 Network and Communication Security

Your network infrastructure is extremely important in protecting your system. Your network needs to support the
communication necessary for your business needs without allowing unauthorized access. A well-defined network
topology can eliminate many security threats based on software flaws (at both the operating system and
application level) or network attacks such as eavesdropping. If users cannot log on to your application or database
servers at the operating system or database layer, then there is no way for intruders to compromise the machines
and gain access to the backend system'’s database or files. Additionally, if users are not able to connect to the
server LAN (local area network), they cannot exploit well-known bugs and security holes in network services on
the server machines.

The network topology for the SAP Quality Issue Management application is based on the topology used by the
SAP NetWeaver platform. Therefore, the security guidelines and recommendations described in the SAP
NetWeaver Security Guide also apply to the SAP Quality Issue Management application. Details that specifically
apply are described in the following sections.

5.6.1 Communication Channel Security

The table below shows the communication channels used by the SAP Quality Issue Management application, the
protocol used for the connection and the type of data transferred.

Table 17:
Communication Path Protocol Used Type of Data Transferred Data Requiring Special Pro-
tection
Frontend client using SAP GUI | RFC, HTTP(S) Integration data Passwords
for Windows to application
server
Frontend client using a Web HTTPS All application data Passwords

browser to application server

Application server to third- HTTPS System ID, client, and host System information (that is,
party application name host name)
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Communication Path Protocol Used Type of Data Transferred Data Requiring Special Pro-
tection
Application server to applica- | RFC Application data (equipment, | System information
tion server functional locations) integra-
tion objects

DIAG and RFC connections can be protected using Secure Network Communications (SNC). HTTP connections
are protected using the Secure Sockets Layer (SSL) protocol.

For more information, see Transport Layer Security in the SAP NetWeaver Security Guide.

5.6.2 Network Security

Your network infrastructure plays a key role in protecting your system. A well-defined network topology can
eliminate many security threats based on software flaws (at the operating system and application level) or
network attacks such as eavesdropping. We offer general recommendations to protect your system landscape,
based on SAP NetWeaver.

For general information about network security, see the SAP NetWeaver Security Guide under http://
help.sap.com/nw731|p Security Information # Security Guide » Network and Communication Security 3.

A minimum security demand for your network infrastructure is the use of a firewall for all your services that are
provided over the Internet. A more secure variant is to protect your systems (or groups of systems) by locating

the system groups in different network segments. Each system group has a firewall that protects it from
unauthorized access. External security attacks can also come from the inside, if the intruder has already taken

control of one of your systems. For more information, see | SAP NetWeaver Security Guide » Network and

Communication Security » Using Firewall Systems for Access Control 1.

SAP QIM uses a so-called “document domain relaxing” in order to navigate into the objects and does not offer
protected applications. Nevertheless, it is possible to establish a DMZ with an SAP Portal via Multiple Network

Zone. For more information, see: |+ SAP NetWeaver Security Guide ¥ Network and Communication Security ¥

Using Multiple Network Zones 1.

1 Note

It is not possible to use the NWBC client here. You need to generate a portal role out of the shipped PFCG roles
for SAP QIM. The generated portal role covers the same functionality like the PFCG role for NWBC.

5.6.3 Communications Destinations

The use of users and authorizations in an irresponsible manner can pose security risks. You should therefore
follow the security rules below when communicating with other systems:

® Employ the user types system and communication.
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e Grant a user only the minimum authorizations.

e Choose a secure password and do not divulge it to anyone else.

® Only store user-specific logon data for users of type system and communication.

e \Wherever possible, use trusted system functions instead of user-specific logon data.

For navigation with NWBC for Desktop, it is necessary to make entries in table HTTP_ WHITELIST. For more
information, see http://help.sap.com/nw731| Application Help * Function-Oriented View » Application Server
Application Server ABAP » Ul Technologies in ABAP » SAP NetWeaver Business Client » Security Aspects »
Whitelist 3.

5.7 Data Protection

Data protection is associated with numerous legal requirements and privacy concerns. In addition to compliance
with general data privacy acts, it is necessary to consider compliance with industry-specific legislation in different
countries. This section describes the specific features and functions that SAP provides to support compliance
with the relevant legal requirements and data privacy. This section and any other sections in this Security Guide
do not give any advice on whether these features and functions are the best method to support company,
industry, regional or country-specific requirements. Furthermore, this guide does not give any advice or
recommendations with regard to additional features that would be required in a particular environment; decisions
related to data protection must be made on a case-by-case basis and under consideration of the given system
landscape and the applicable legal requirements.

1 Note

In the majority of cases, compliance with data privacy laws is not a product feature. SAP software supports
data privacy by providing security features and specific data-protection-relevant functions such as functions
for the simplified blocking and deletion of personal data. SAP does not provide legal advice in any form. The
definitions and other terms used in this guide are not taken from any given legal source.

Table 18: Glossary

Term Definition

Personal data Information about an identified or identifiable natural person.

Business purpose A legal, contractual, or in other form justified reason for the
processing of personal data. The assumption is that any pur-
pose has an end that is usually already defined when the pur-
pose starts.

Blocking A method of restricting access to data for which the primary
business purpose has ended.

Deletion Deletion of personal data so that the data is no longer usable.

Retention period The time period during which data must be available.
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Term Definition

End of purpose (EoP) A method of identifying the point in time for a data set when
the processing of personal data is no longer required for the
primary business purpose. After the EoP has been reached,
the data is blocked and can only be accessed by users with
special authorization.

Some basic requirements that support data protection are often referred to as technical and organizational
measures (TOM). The following topics are related to data protection and require appropriate TOMs:

® Access control: Authentication features as described in section User Administration and Authentication.

e Authorizations: Authorization concept as described in section Authorizations.

® Read access logging: as described in section Read Access Logging.

e Transmission control: as described in section Network and Communication Security.

e Input control: Change logging is described in the application-specific documentation under http://
help.sap.com/qim100 |» Application Help » English » Issue Processing » Change Documents 1.

e Availability control as described in:
o SAP NetWeaver Database Administration documentation

o SAP Business Continuity documentation in the SAP NetWeaver Application Help under | Function-

Oriented View ¥ Solution Life Cycle Management » SAP Business Continuity 3

e Separation by purpose: Is subject to the organizational model implemented and must be applied as part of
the authorization concept.

Caution

The extent to which data protection is ensured depends on secure system operation. Network security,
security note implementation, adequate logging of system changes, and appropriate usage of the system are
the basic technical requirements for compliance with data privacy legislation and other legislation.

5.7.1 Deletion of Personal Data

Use

SAP QIM might process data (personal data) that is subject to the data protection laws applicable in specific
countries as described in SAP Note 1825544#% . The SAP Information Lifecycle Management (ILM) component
supports the entire software lifecycle including the storage, retention, blocking, and deletion of data. SAP QIM
uses SAP ILM to support the deletion of personal data as described in the following sections. SAP delivers an end
of purpose check for business partners, customers and vendors assigned to QIM quality issues and activities. For
information about the settings required, see Customizing for QIM under |+ Environment » Define End of Purpose

for Personal Data 3.
End of Purpose Check (EoP)

An end of purpose check determines whether data is still relevant for business activities based on the retention
period defined for the data. The retention period of data consists of the following phases.
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e Phase one: The relevant data is actively used.

® Phase two: The relevant data is actively available in the system.

e Phase three: The relevant data needs to be retained for other reasons
For example, processing of data is no longer required for the primary business purpose, but to comply with
legal rules for retention, the data must still be available. In phase three, the relevant data is blocked.
Blocking of data prevents the business users of SAP applications from displaying and using data that may
include personal data and is no longer relevant for business activities.

Blocking of data can impact system behavior in the following ways:

e Display: The system does not display blocked data.
e (Change: It is not possible to change a business object that contains blocked data.
e C(Create: Itis not possible to create a business object that contains blocked data.

e Copy/Follow-Up: Itis not possible to copy a business object or perform follow-up activities for a business
object that contains blocked data.

e Search: Itis not possible to search for blocked data or to search for a business object using blocked data in
the search criteria.

Itis possible to display blocked data if a user has special authorization; however, it is still not possible to create,
change, copy, or perform follow-up activities on blocked data.

Relevant Application Objects and Available Deletion Functionality

Table 19:

Application Object Detailed Description Provided Deletion Functionality

Quality Issue Quality issues created in SAP QIM Archiving Object /IAM/ISSUE

Related ILM Object 1AM ISSUE

Quiality Activity Quality activities created in SAP QIM Archiving Object /IaM/ACT

Related ILM Object 1AM ACTIVITY

Relevant Application Objects and Available EoP functionality

Table 20:

Application Object Detailed Description Implemented Solution

Business Partner Business partners assigned as partners | EoP check
to quality issues or activities

Customer Assigned as reference object EoP check
Vendor Assigned as reference object EoP check
Caution

Note that the Reported By field that is available for quality issues is a free text field. Therefore it is not included
in the EoP check. Within your organization, make sure that only data is stored in this field that is not subject to
data protection.
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Procedure

1. Before archiving data, you must define residence time and retention periods in SAP Information Lifecycle
Management (ILM).

2. You choose whether data deletion is required for data stored in archive files or data stored in the database,
also depending on the type of deletion functionality available.
3. Youdo the following:
o Runtransaction IRMPOL and maintain the required residence policies for the central business partner
(ILM object: ca_BUPA, application 12M).
© Runtransaction BUPA PRE_EOP to enable the end of purpose check function for the central business
partner.
o Run transaction IRMPOL and maintain the required residence policies for the customer and vendor
reference in QIM (ILM object cA_BUPA, application 1aM_cUs for customers and 1aM_VEN for vendors).

o Runtransaction cvP_PRE EOP to enable the end of purpose check function for the customer master and
vendor master in SAP ERP.
4. Business users can request unblocking of blocked data by using the transaction BUP_ REQ UNBLK.

5. Ifyou have the needed authorizations, you can unblock data by running the transaction BUPA PRE_EOP and
CVP_UNBLOCK_MD.

6. You delete data by using the transaction ILM DESTRUCTION for the ILM objects of SAP QIM.

For information about how to configure blocking and deletion for SAP QIM, see Customizing for QIM under

|» Environment » Define End of Purpose for Personal Data 3.

5.7.2 Read Access Logging

If no trace or log is stored that records which business users have accessed data, it is difficult to track the
person(s) responsible for any data leaks to the outside world. The Read Access Logging (RAL) component can be
used to monitor and log read access to data and provide information such as which business users accessed
personal data, for example, of a business partner, and in which time frame. In RAL, you can configure which read-
access information to log and under which conditions.

For more information, see the SAP NetWeaver Library under http://help.sap.com/nw731|p Application Help »
Function-Oriented View ¥ Security i System Security » System Security for SAP NetWeaver Application Server
ABAP Only » Read Access Logging 4.

5.8 Enterprise Services Security
The following chapters in the NetWeaver Security Guide are relevant for all enterprise services delivered with SAP
Quality Issue Management:

http://help.sap.com/nw731l} Security Information » Security Guide 3

e User Administration and Authentication
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e Network and Communication Security

e SAP NetWeaver Process Integration Security Guide

e Security Guides for Connectivity and Interoperability Technologies
e Security Aspects for Web Services

e Security Aspects for Lifecycle Management

e Security Guides for Operating System and Database Platforms

5.9 Security-Relevant Logging and Tracing

The trace and log files of SAP Quality Issue Management use the standard mechanisms of SAP NetWeaver. For
more information, see the SAP NetWeaver Security Guide under http://help.sap.com/nw731| Security
Information » Security Guide » Security Aspects for Lifecycle Management » Auditing and Logging 3.

Changes to anissue or activity in SAP Quality Issue Management are documented by means of change

documents. In addtion, you can specify for each text type that a history is stored for the long texts entered in the
various text areas (historical texts). For more information, see the SAP Library for SAP QIM under http://

help.sap.com/qim100| Application Help » SAP Library ¥ Issue Processing 4.

SAP Quality Issue Management
Security Information CUSTOMER

43


http://help.sap.com/nw731
http://help.sap.com/qim100
http://help.sap.com/qim100

6 Solution-Wide Topics

6.1 List of References

The following is a list of references to technologies used for SAP Quality Issue Management.

Information about technologies in SAP NetWeaver can be found on SAP Help Portal at http://help.sap.com/

nw731| Application Help ¥ Function-Oriented View 3.

Table 21:

Topic Where to find

Ul Technologies, for example, Web Dynpro, ABAP, Floorplan
Manager, NWBC

|} SAP NetWeaver Library: Function-Oriented View >
Application Server » Application Server ABAP ¥ Ul
Technologies in ABAP 3.

Business Rule Framework plus

|} SAP NetWeaver Library: Function-Oriented View >
Application Server > Application Server ABAP > Other
Services > Services for Application Developers > Business

Rule Framework plus }

Search and Operational Analytics

|} SAP NetWeaver Library: Function-Oriented View > Search
and Operational Analytics }

Adobe Document Services for Form Processing

|} SAP NetWeaver Library: Function-Oriented View >
Application Server # Application Server ABAP » Adobe

Document Services for Form Processing 4.

Portal

| SAP NetWeaver Library: Function-Oriented View ¥
Enterprise Portal Server > Portal }

Information about additional technologies being re-used by SAP QIM can be found in the SAP QIM documentation
on SAP Help Portal at http://help.sap.com/qim100|¢ Application Help # SAP Library ¥ SAP Quality Issue

Management 3.
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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